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• Component of the NOAA CoastWatch Satellite Training Course

• Comprised of 3 modules:  Data, Tools, Exercise(s)

• Uses ESRI ArcMap, but techniques work with QGIS and other 
GIS software

• Updated from CoastWatch Satellite GIS training originally given 
in 2000 for avenue-based ArcView 3.1

This Training

Presenter
Presentation Notes
Script:  This component of the NOAA CoastWatch Satellite Course will provide an overview of methods and tools to work with satellite data products.  The screenshots used are from ArcMap and the Environmental Data Connector.  By the end of this module,  you should have an understanding of the various ways to get satellite data into GIS.
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A few notes on ArcMap for NOAA Users

• The exercises and screenshots were created using ArcGIS 10.7
• The current version of ArcMap is 10.8.1
• The EDC has been updated and will install with any version of 

ArcMap 10.4+
• ArcMap 10.8.1 is the final release of ArcMap and all future 

development will go into ArcGIS Pro. ArcMap 10.8.1 will continue to 
be supported until 2026 via the normal Esri support cycle. If you 
are unsure of which product to choose, consider ArcGIS Pro. 

• ESRI support for ArcMap 10.8.1

This slide has no audio
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ESRI support 
for ArcMap 
10.8.1

This slide has no audio



Using Satellite Data in GIS:  Exercise

Michael Soracco
NOAA Affiliate for NOAA CoastWatch
College Park, MD

Versioning:
2020, Soracco, ArcMap 10.7

https://coastwatch.noaa.gov
coastwatch.info@noaa.gov

Presenter
Presentation Notes
https://coastwatch.gitbook.io/satellite-course/tutorials/python-tutorial/4.-extract-data-along-a-turtle-track

ArcGIS Exercise:  (parallel https://coastwatch.gitbook.io/satellite-course/tutorials/python-tutorial/4.-extract-data-along-a-turtle-track,  including modified Jupyter notebook for ArcGIS)
Extract data along a turtle track
Import Turtle CSV: The track data can be downloaded here: https://oceanwatch.pifsc.noaa.gov/files/25317_05.dat
Convert to Shape
Import Chlor and SST
Methods
Point-by-point via ERDDAP/THREDDS
Obtain raster
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Exercise Background

• Patterned after Python Exercise:  “Extract 
data along turtle track”  --
https://coastwatch.gitbook.io/satellite-course/tutorials/python-tutorial/4.-extract-data-
along-a-turtle-track

• Uses import of NetCDF, CSV

• Builds upon “ArcGIS Tutorial” and 
TurtleWatch Zone -- https://coastwatch.gitbook.io/satellite-

course/tutorials/arcgis-tutorial

• Identifies 0 to 360 and 
-180 to 180 longitude issues

Multi-year turtle track atop single SST image
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ArcGIS:  Extract data along a turtle track
• Scenario:  A juvenile loggerhead sea turtle (ARGOS ID 25317) provided positional data 

over a period of three years

• Research Question:  Does this sea turtles’ behavior correspond to oceanographic surface 
parameters such as sea surface temperature?  Does the turtle remain within the 
TurtleWatch Area (17.5° to 18.5°C)?

• Conditions:
• Date range: May 2005 – 2008 (1232 days)

• Distance travelled:  19,491 km

• Tracking Duty Cycle: 
• 6 hours on , 48 hours off
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Strategy

There are often several pathways to achieve the same results using GIS. 

Output
•Map
•Data

Spatial 
Analysis
•Feature/raster
•Sampling
•Graphing

Load Data
•Import method
•Enable time
•Color bar
•Data selection
•Time Slider

Prepare DataObtain DataDefine 
Problem

Turtle track and 
Ocean 

parameters

0 to 360°

Convert longitude?

Format

-180° to 180° Format,
Projection

GIS

OpenDAP
ERDDAP

THREDDS
EDC

Add XY 
Data/Feature 

Class

Extraction
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Strategy

• Perform matchup of turtle locations with parameters
• Import Turtle CSV: 

• https://oceanwatch.pifsc.noaa.gov/files/25317_05.dat

• Convert to Feature Layer / Shapefile

• Obtain SST satellite data for geographic coverage and period of study

• Outputs:
1. Overview map – example day of parameter and turtle tracks
2. Map output showing turtle locations and parameter values
3. Graph of parameter value for each turtle location vs Time
4. Export Movie showing Turtle, Parameter, TurtleWatch Zone
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Output 1:  Overview Map

• Allows a quick look at the data types and extents we’ll be working with

• For the Overview Map,  only the turtle track CSV file is required.

• Displaying a parameter (i.e.  SST) is optional,  but the map should be labeled that the 
SST data is from a single day.

• Use 0->360 data for this Overview Map

• As a general rule-of-thumb,  load raster data first as ArcMap will use the coordinate 
system of the raster data
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Output 1:  Overview Map

• Obtain SST data from 
https://oceanwatch.pifsc.noaa.gov/

• in 0-360
• a SINGLE date between the start/end 

of the turtle track – i.e.  October 10, 
2006

• ERDDAP Link

https://oceanwatch.pifsc.noaa.gov/
https://oceanwatch.pifsc.noaa.gov/erddap/griddap/goes-poes-1d-ghrsst-RAN.nc?analysed_sst%5B(2006-10-10T12:00:00Z)%5D%5B(-89.975):(89.975)%5D%5B(0.025):(359.975)%5D&.draw=surface&.vars=longitude|latitude|analysed_sst&.colorBar=|||||&.bgColor=0xffffffff
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Output 1:  Overview Map

• Obtain Turtle Track

• Data Link

"mean_lon","mean_lat","year","month","day" 
176.619432886108,32.6787283689241,2005,5,4 
176.783786497336,32.755450905856,2005,5,5 
177.086094792196,32.8703371644739,2005,5,6 
177.523857440759,32.8593957701299,2005,5,7 
178.058144591188,32.6740108044364,2005,5,8 
178.477225321586,32.4596669014395,2005,5,9 
178.739279086398,32.3402034409515,2005,5,10 
178.959668448728,32.2630123770382,2005,5,11 
179.19299156409,32.1452863228285,2005,5,12

https://oceanwatch.pifsc.noaa.gov/files/25317_05.dat

https://oceanwatch.pifsc.noaa.gov/files/25317_05.dat
https://oceanwatch.pifsc.noaa.gov/files/25317_05.dat
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Output 1:  Overview Map

• Open ArcMap to Blank Map

• Drag-and-Drop the NetCDF
file onto the View

• SST data is 0-360
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Output 1:  Overview Map

• Add XY Data to import Turtle 
Track using one of these 
methods

• Add Data Icon,  locate CSV, 
right-mouse Add X-Y 

• File->Add Data->Display X-Y 
Data

• Set the X and Y Fields
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Output 1:  Overview Map

• Obtain Turtle Track

• Data Link
• Save As: 25317_05.dat.csv

https://oceanwatch.pifsc.noaa.gov/files/25317_05.dat

https://oceanwatch.pifsc.noaa.gov/files/25317_05.dat
https://oceanwatch.pifsc.noaa.gov/files/25317_05.dat
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Output 1:  Overview Map

• Tailor the Map
• Options:

• Title
• Color symbology to SST
• Turtle track icon/color
• Basemap / Labels 
• Map properties (Legend, 

scale, North arrow, 
graticules)
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Output 1:  Overview Map

• Label the Layout View
• Save the map as an 

image file
• We now have an 

overview of the 3+ 
year Turtle track
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Overview Map -- Observations

• Data is displayed across the Dateline
• Loading X-Y Data created a table for display only (not 

queryable/selectable)
• Drag-and-drop worked well for the single NetCDF image and 

subsequent data matched the coordinate system of the raster 
layer.

• Given the extent of the track spatially and temporally,  that could 
result in a lot of data…
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Strategy Adjustments

• Reduce study area to:
• Feature of interest
• ~15 months or (37% of 

total track time)
• Geographic area

• Lat:  31-42 deg N
• Long360: 189 to 200 deg
• Long180: -171 to -160 deg

• Work in -180 to 180
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Data Preparation  -- Turtle Data

• Turtle CSV: 
https://oceanwatch.pifsc.noaa.gov/files/25317_05.dat 

• No metadata
• One X-Y pair per day
• Satellite tracking so we’ll assume WGS84 Ellipsoid / Datum

https://oceanwatch.pifsc.noaa.gov/files/25317_05.dat
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Data Preparation – Turtle Data (cont.)

• Headers:  "mean_lon","mean_lat","year","month","day"
• Save As  .csv;  load into a spreadsheet or use ‘more’ in Linux to see file contents

• Other observations about the CSV
• Temporal Range:  May 4, 2005 – September 18, 2008
• Spatial Range: 

• Latitude:  22.70 to 43.86;  
• Longitude:  175.86 to 249.28  (175.86E to 110.72W)

• Longitudes 0 to 360 degrees. [Most GIS can handle 0-360 but not with all tools]
• Separate fields for Year, Month, Day. No times.

mean_lon mean_lat year month day
176.6194329 32.67873 2005 5 4
176.7837865 32.75545 2005 5 5
177.0860948 32.87034 2005 5 6
177.5238574 32.8594 2005 5 7

mean_lon mean_lat year month day
247.0782107 22.70993 2008 6 9
247.0520168 22.74948 2008 6 8
247.1459359 22.75972 2008 6 10
247.0483884 22.83755 2008 6 7
247.2265195 22.85263 2008 6 11

Mean Location

Day, 0hr

Day, 24hr
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Data Preparation:  Input data modification

• Modify the dat/CSV file.  Combine the Year, Month, Day to a single field.  
For this exercise using ArcMap,  the following conventions are preferred:

• A coverage or shapefile identifies dates in a date field with this format: yyyy-mm-dd. 
• A geodatabase formats the date as datetime yyyy-mm-dd hh:mm:ss AM or PM

• Use a spreadsheet and create a Date column with ‘=DATE(C2,D2,E2)’ to 
convert into a date and re-format to custom yyyy-mm-dd

• Use a spreadsheet and  create a mean_lon180 column with ‘=A1-360’

• Reorder columns:  Date, mean_lon180, mean_lat, etc.  Save as CSV

Action:  Use a spreadsheet 
and modify the CSV file:  
• Add mean_lon180 
• Add Date
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Obtain Satellite Data

• SST 
• Require values of each parameter
• Source of turtle data is mean lat/long, can a turtle travel more 

than 1km or 5km in a day?  
• Temporal period is daily,  multiyear
• NOAA Blended SST a good candidate

• Use either EDC, ERDDAP, THREDDS, OpenDAP to obtain 
a NetCDF dataset with daily time ‘slices’.

• Note if using 0 to 360 or -180 to 180;  Choose to match 
other data

• The following slides show multiple means to obtain the data
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Obtain Satellite Data

• ERDDAP:
• 0-360:  goes-poes-1d-ghrsst-RAN_360_turtle2005-2007.nc

• https://oceanwatch.pifsc.noaa.gov/erddap/griddap/goes-poes-1d-ghrsst-RAN.nc?analysed_sst[(2005-
12-20T12:00:00Z):1:(2007-04-07T12:00:00Z)][(31):1:(42)][(188):1:(201)]

• -180 to 180:  noaacwBLENDEDsstDaily_180_turtle2005-2007.nc
• https://coastwatch.noaa.gov/erddap/griddap/noaacwBLENDEDsstDaily.nc?analysed_sst[(2005-12-

20T12:00:00Z):1:(2007-04-07T12:00:00Z)][(31):1:(42)][(-171):1:(-160)]

• THREDDS (Aggregated View):
• https://coastwatch.noaa.gov/thredds/ncss/BlendedSST5kmNightAggGHRSSTSTARLoM?v

ar=analysed_sst&north=42&west=-171&east=-
160&south=31&disableProjSubset=on&horizStride=1&time_start=2005-12-
20T12%3A00%3A00Z&time_end=2007-04-
07T12%3A00%3A00Z&timeStride=1&accept=netcdf

https://oceanwatch.pifsc.noaa.gov/erddap/griddap/goes-poes-1d-ghrsst-RAN.nc?analysed_sst%5b(2005-12-20T12:00:00Z):1:(2007-04-07T12:00:00Z)%5d%5b(31):1:(42)%5d%5b(188):1:(201)%5d
https://coastwatch.noaa.gov/erddap/griddap/noaacwBLENDEDsstDaily.nc?analysed_sst%5b(2005-12-20T12:00:00Z):1:(2007-04-07T12:00:00Z)%5d%5b(31):1:(42)%5d%5b(-171):1:(-160)%5d
https://coastwatch.noaa.gov/thredds/ncss/BlendedSST5kmNightAggGHRSSTSTARLoM?var=analysed_sst&north=42&west=-171&east=-160&south=31&disableProjSubset=on&horizStride=1&time_start=2005-12-20T12%3A00%3A00Z&time_end=2007-04-07T12%3A00%3A00Z&timeStride=1&accept=netcdf
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Obtain Satellite Data -- THREDDS

• THREDDS (Aggregated View)
• NCSubsetService
• Generates URL in addition to fetching data

https://coastwatch.noaa.gov/thredds/ncss/BlendedSST5kmNightAggGHRSSTSTARL
oM?var=analysed_sst&north=42&west=-171&east=-
160&south=31&disableProjSubset=on&horizStride=1&time_start=2005-12-
20T12%3A00%3A00Z&time_end=2007-04-
07T12%3A00%3A00Z&timeStride=1&accept=netcdf

https://coastwatch.noaa.gov/thredds/ncss/BlendedSST5kmNightAggGHRSSTSTARLoM?var=analysed_sst&north=42&west=-171&east=-160&south=31&disableProjSubset=on&horizStride=1&time_start=2005-12-20T12%3A00%3A00Z&time_end=2007-04-07T12%3A00%3A00Z&timeStride=1&accept=netcdf
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Obtain Satellite Data

• EDC

• Graphical 
interface to 
define extent, 
time, variables

• Automatically 
loads into GIS
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Obtain Satellite Data

• EDC

• Can load the track 
and only pull the 
raster values for 
each point/time
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Loading Satellite Data

• Open ArcMap to Blank Map

• Open ArcToolBox

• Use Multidimension Tools:
• Make NetCDF Raster Layer

• Set the Input netCDF file
• noaacwBLENDEDsstDaily_180_turtle2005-2007.nc

• Confirm Variable, X, and Y 
Dimensions

• Add time as a Dimension Value
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Loading Satellite Data  -- Layer Properties – General / Extent

• Rename:
• Layer:  

• Sea Surface Temperature (NOAA)
• Description
• Credit

• Confirm Extent
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Loading Satellite Data  -- Layer Properties -- Symbology

• Reset the Stretch type to 
Minimum-Maximum

• Reset the High/Low Values to 
280-305

• Select a color ramp of choice
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Loading Satellite Data -- Layer Properties -- NetCDF

• Verify the NetCDF settings
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Loading Satellite Data -- Layer Properties -- Time

• Enable Time on the Layer
• Set the Time Dimension to ‘time’
• Set the Step Interval to ‘1’

• You may need to revisit this as 
ArcMap will rest the value when 
Calculating range

• Set the Time Zone to UTC
• Click ‘Apply’ and verify values
• Click ‘OK’
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Display Satellite Data

• Enable Time Slider

• Click the ‘Play’ Arrow
• The images should 

change as the dates 
advance

• The color scale range 
should remain the same 
for each time step
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Time Slider

• Controls time for all layers in map 
(Enable/Disable) and Tools

• If layers do not display,  check:
• Time Zone
• Step Interval
• Time Window

• Exports movie
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Loading Data:  CSV file

• Use the CSV file: 
• 25317_05_dat_DATE_LON180.csv

• Choose a method to import the 
CSV file

• Add XY Data, or
• Create Feature Class from X-Y Table

• Export as Shapefile [Feature Class will 
do this automatically]
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Loading Data:  CSV file               Add XY Data

1. Open ArcMap

2. Open a Blank Map

3. Select file->Add Data->Add XY 
Data
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Loading Data:  CSV file               
Add XY Data

1. Set the table to your 
CSV file

2. Set the X,Y Fields
3. Edit and Set the 

Coordinate System 
[Global Coordinate 
System -> WGS1984]

4. Click OK

lon180 may be your X Field
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Loading Data:  CSV file               
Add XY Data

1. An Object-ID warning 
may appear

2. Click OK
3. If the warning 

appeared,  Export the 
data and re-add the 
layer to Map
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Loading Data:  CSV file               Add XY Data

• By default,  the View will show -
180 to 180,  splitting the data at the 
‘dateline’ 

• When we adjusted the longitudes 
(subtracting 360), the East 
longitudes become ‘westernized’  
as values less than -180. 
Depending on how the data are 
loaded and assigned projection,  
they can display across the 
dateline.

180E
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Loading Data:  CSV file               Create Feature Class

• Open the Catalog
• Navigate to the CSV file and right-

click
• Select Create Feature Class
• Populate the Input Fields, 

Coordinate System, and Output 
shapefile location

• A notification may suggest adding 
an ObjectID
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Loading Data:  CSV file               Create Feature Class

• Set/Confirm the Coordinate system

• Select Global Coordinate System

• Select WGS1984
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Loading Data:  CSV file

• Verify the Coordinate System 
under the Source tab
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Feature Layer Workflow

• The entire Turtle Track is loaded

• Reduce/filter track to only dates between 
12/20/2005 and 4/07/2007

• Perform spatial-temporal sampling with the new 
Track and SST layer

• Select events from the results to reduce the 
results to the track points and corresponding SST 
by date

• Export data, Add as layer

• Proceed
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Filter the Feature Layer

• Open ‘Select by 
Attributes’

• Use Date in the 
SELECT statement 
to 

• Other selection 
methods could 
achieve the same 
results

"Date" >=  date '2005-12-20 00:00:00' AND "Date" <= date '2007-04-07 00:00:00'
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Save the Selection as a Layer

• Right-mouse click on the 
feature layer

• Follow the Selection 
menu to ‘Create Layer 
From Selected Features’

• When prompted,  accept 
‘Add this layer to map’
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Enable Time on the Selection Layer

• Open Layer Properties

• Check the ‘Enable time on this 
layer’ box

• Set Time Step Interval to 1 Days

• Set Time Zone to UTC

• Click Apply and Calculate

• Reset Time Step Interval to ‘1’ and 
‘Days’

• Click OK
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• ArcGIS: 
• https://desktop.arcgis.com/en/a

rcmap/10.3/tools/spatial-
analyst-toolbox/an-overview-of-
the-extraction-tools.htm

• ArcToolbox->Spatial Analyst Tools->Extraction ‣
Sample

• QGIS:
• https://docs.qgis.org/3.10/en/do

cs/user_manual/processing_alg
s/qgis/rasteranalysis.html#sam
ple-raster-values

• Processing->Toolbox-> Raster analysis ‣
Sample raster values algorithm

474 
days

Extracting data from the Raster Layer by using the Feature Layer

December 20, 2005

April 7, 2007

December 20, 2005

April 7, 2007

Feature Layer

Raster Layer

https://desktop.arcgis.com/en/arcmap/10.3/tools/spatial-analyst-toolbox/an-overview-of-the-extraction-tools.htm
https://docs.qgis.org/3.10/en/docs/user_manual/processing_algs/qgis/rasteranalysis.html#sample-raster-values
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• By default,  the tool will operate for 
all points on a single ‘slice’ of the 
Raster cube.

• Resulting table is a single layer 
raster extraction for December 
20,2005 for all points (Dec 2005 to 
April 2007).  

Extracting data using the Sample Tool

474 days

December 20, 2005

April 7, 2007

December 20, 2005
April 7, 2007

474 days
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• Tool performs multidimensional 
extraction retrieving values for all 
slices

• Resulting table has raster values 
for each point for each time slice

Extracting data using the Sample Tool

474 days

December 20, 2005

April 7, 2007

December 20, 2005
April 7, 2007

474 days
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• Our result requires selecting the 
records from the results table to 
build a layer with the appropriate 
x,y,t between the point and raster 
layer

474 days

December 20, 2005

April 7, 2007

December 20, 2005

April 7, 2007

474 days

Extracting data using the Sample Tool
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Using the Selected Feature Layer for Sampling

• The selected feature layer contains 474 points.  
• The SST layer contains 474 raster layers;  one for each day.
• Most geoprocessing tools will work with time (which in ArcMap is 

managed by the Time Slider), but not always how we would expect.
• The Sample tool will obtain an SST value for each point on each day.  

[474 points * 474 days = 224676 records]
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Perform the Sampling

• Open the ArcToolBox

• Find Spatial Analyst Tools-
>Extraction->Sample

• Double-click to activate 
Sample tool
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Perform the Sampling

• Set the input raster and location 
source fields

• Set a name for the output table

• Sampling tool has a checkbox to 
enable using multidimensions

By default (multidimensional unchecked),  the tool will 
work on the current date selected in the Time Slider
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Perform the Sampling

• Right-mouse and open the 
data table on the 
turtlesamples table

• Note the layout of the table
• Multiple entries per date
• Analysed_sst column added
• Rowid prefixed to the table
• 224,676 records total
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Filter the Sampling Results

• Select by Attribute  
• Design an algorithm to grab 

every 475th row.
• MOD(OBJECTID+2n-x, n) = 0

• n is the every nth record
• x is the objectid to start from

• MOD( "Rowid"+949,475)=0
• Note,  Rowid may be 

OBJECT_ID depending on how 
data was added

Presenter
Presentation Notes
Sample gives results across all dimensions.  IOW,  each point and each SST time slice is stored in the results table -- 474 records per day.  To extract the single turtle location and SST over time,  we need to query the results.  Looking at the results table,  points [0,474] have a recorded SST per day.  So,  we need to find entries in the table by Record ID and incremented point index.
�For example,  the first point is OBJECTID 1 and Point index of 0.  The next point in the track is point 1,  but for the next day is stored in OBJECTID 475.  So advancing each day,  we add 474 to OBJECTID and 1 to the Point index.
�
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Filter the Sampling Results

• Our results have 474 records
• The 2nd column shows the 

sequential order of points in the 
track

• The Time column matches the 
Date range we expect.  

• This selection must be exported 
and then displayed to aid in our 
final outputs.

• Add the new table to the map 

Presenter
Presentation Notes
Sample gives results across all dimensions.  IOW,  each point and each SST time slice is stored in the results table -- 474 records per day.  To extract the single turtle location and SST over time,  we need to query the results.  Looking at the results table,  points [0,474] have a recorded SST per day.  So,  we need to find entries in the table by Record ID and incremented point index.
�For example,  the first point is OBJECTID 1 and Point index of 0.  The next point in the track is point 1,  but for the next day is stored in OBJECTID 475.  So advancing each day,  we add 474 to OBJECTID and 1 to the Point index.
�
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Display the Sampling Results

• Display the selected results
• Enable Time (Layer 

Properties)

Presenter
Presentation Notes
Sample gives results across all dimensions.  IOW,  each point and each SST time slice is stored in the results table -- 474 records per day.  To extract the single turtle location and SST over time,  we need to query the results.  Looking at the results table,  points [0,474] have a recorded SST per day.  So,  we need to find entries in the table by Record ID and incremented point index.
�For example,  the first point is OBJECTID 1 and Point index of 0.  The next point in the track is point 1,  but for the next day is stored in OBJECTID 475.  So advancing each day,  we add 474 to OBJECTID and 1 to the Point index.
�
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• Rename samples layer
• Modify Icon
• Remove Turtle2005-

2007 layer and table
• Enable Time Slider
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Output 2: Map output showing turtle locations and parameter values

• Disable Time (on slider)
• Open Layer Properties 

on Turtle layer
• Assign color ramp and 

classification – 25 levels 
(Quantities to 
analysed_sst)

• Turn off raster visibility
• Turn on Basemap
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Output 3:  Graph of parameter value for each turtle location vs Time

• Open the 
SamplesTurtleTrackTble

• Rename the ANALYSED_S 
column to Temperature(K)

• Select ‘Create Graph’
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Output 3:  Graph of parameter value for each turtle location vs Time

• Select the Graph type:  
Vertical Line

• Set the Y and X axes
• Temperature(K) vs Time

• Continue with the Wizard 
to finalize your chart.



NOAA CoastWatch https://coastwatch.noaa.gov                Training 2022, Virtual                 62

Output 3:  Graph of parameter value for each turtle location vs Time

Temperature (K) encountered by Turtle Tag 25317

Data courtesy NOAA
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Output 4: Export Movie showing Turtle, Parameter, TurtleWatch Zone

• TurtleWatch Zone:
1. Most loggerhead turtles stay in water colder than 65.5°F (about 

18.5°C). When the 65.5°F temperature contour is drawn on a map of 
the current sea surface temperature conditions, it delineates the current 
southern boundary of the loggerhead's preferred habitat. Over 50% of 
recorded loggerhead interactions occurred in waters between this 
southern 65.5°F boundary and the 63.5°F temperature contour to the 
north.

2. Converting F to K:  290.65 – 291.65 K

https://www.fisheries.noaa.gov/resource/map/turtlewatch
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Output 4: Export Movie showing Turtle, Parameter, TurtleWatch Zone

• Copy and Paste SST 
raster layer

• Rename and Open SST 
raster Layer Properties
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Output 4: Export Movie showing Turtle, Parameter, TurtleWatch Zone

• Steps:
1. Add TurtleWatch

Zone

2. Export Movie
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Time Slider – Check Settings

• If layers do not display,  check:
• Time Zone
• Step Interval
• Time Window

• When the Feature data were 
added,  the time defaulted to 
MM/DD/YYYY 00:00 AM,  so 
the time window must be set to 
allow display of both the Raster 
and Points Layers
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Output 4: Export Movie showing Turtle, Parameter, TurtleWatch Zone

• Save your work!
• Use the Time 

Slider to save the 
movie

• Select a codec 
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Other considerations

• Time:   Consider adding a default time to the Turtle Points 

• Units:   Kelvin is not usually easily related to when communicating 
temperature.  Use the appropriate units to communicate your results.  
The Map Algebra->Raster Calculator or Math->Minus tools can be 
used to convert the Raster data to either degrees Celsius or 
Farenheit.

• Sampling:  Often, tools can accept multiple raster layers to sample.  If 
you have a few raster datasets,  try loading each time slice as a 
separate layer.  You could also do this with multiple parameters.  
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End of Exercise

https://coastwatch.noaa.gov
coastwatch.info@noaa.gov

Presenter
Presentation Notes
https://coastwatch.gitbook.io/satellite-course/tutorials/python-tutorial/4.-extract-data-along-a-turtle-track

ArcGIS Exercise:  (parallel https://coastwatch.gitbook.io/satellite-course/tutorials/python-tutorial/4.-extract-data-along-a-turtle-track,  including modified Jupyter notebook for ArcGIS)
Extract data along a turtle track
Import Turtle CSV: The track data can be downloaded here: https://oceanwatch.pifsc.noaa.gov/files/25317_05.dat
Convert to Shape
Import Chlor and SST
Methods
Point-by-point via ERDDAP/THREDDS
Obtain raster



	Using Satellite Data in GIS
	This Training
	A few notes on ArcMap for NOAA Users
	ESRI support for ArcMap 10.8.1
	Using Satellite Data in GIS:  Exercise
	Exercise Background
	ArcGIS:  Extract data along a turtle track
	Strategy
	Strategy
	Output 1:  Overview Map
	Output 1:  Overview Map
	Output 1:  Overview Map
	Output 1:  Overview Map
	Output 1:  Overview Map
	Output 1:  Overview Map
	Output 1:  Overview Map
	Output 1:  Overview Map
	Overview Map -- Observations
	Strategy Adjustments
	Data Preparation  -- Turtle Data
	Data Preparation – Turtle Data (cont.)
	Data Preparation:  Input data modification
	Obtain Satellite Data
	Obtain Satellite Data
	Obtain Satellite Data -- THREDDS
	Obtain Satellite Data
	Obtain Satellite Data
	Loading Satellite Data
	Loading Satellite Data  -- Layer Properties – General / Extent
	Loading Satellite Data  --  Layer Properties -- Symbology
	Loading Satellite Data --  Layer Properties -- NetCDF
	Loading Satellite Data --  Layer Properties -- Time
	Display Satellite Data
	Time Slider
	Loading Data:  CSV file
	Loading Data:  CSV file               Add XY Data
	Loading Data:  CSV file               Add XY Data
	Loading Data:  CSV file               Add XY Data
	Loading Data:  CSV file               Add XY Data
	Loading Data:  CSV file               Create Feature Class
	Loading Data:  CSV file               Create Feature Class
	Loading Data:  CSV file
	Feature Layer Workflow
	Filter the Feature Layer
	Save the Selection as a Layer
	Enable Time on the Selection Layer
	Extracting data from the Raster Layer by using the Feature Layer
	Extracting data using the Sample Tool
	Extracting data using the Sample Tool
	Extracting data using the Sample Tool
	Using the Selected Feature Layer for Sampling
	Perform the Sampling
	Perform the Sampling
	Perform the Sampling
	Filter the Sampling Results
	Filter the Sampling Results
	Display the Sampling Results
	Slide Number 58
	Output 2: Map output showing turtle locations and parameter values
	Output 3:  Graph of parameter value for each turtle location vs Time
	Output 3:  Graph of parameter value for each turtle location vs Time
	Output 3:  Graph of parameter value for each turtle location vs Time
	Output 4: Export Movie showing Turtle, Parameter, TurtleWatch Zone
	Output 4: Export Movie showing Turtle, Parameter, TurtleWatch Zone
	Output 4: Export Movie showing Turtle, Parameter, TurtleWatch Zone
	Time Slider – Check Settings
	Output 4: Export Movie showing Turtle, Parameter, TurtleWatch Zone
	Other considerations
	End of Exercise
	Extra Slides on the EDC Tool
	Slide Number 71
	EDC Track Line Format
	Slide Number 73
	Slide Number 74
	Slide Number 75
	Slide Number 76



